
В Е С Т Н И К  П Н И П У  

2017  Машиностроение, материаловедение Т. 19, № 1 

 41

DOI: 10.15593/2224-9877/2017.1.03  
УДК 544.772:61 

А.М. Игнатова1, В.И. Верещагин2  

1 Пермский национальный исследовательский  
политехнический университет, Пермь, Россия 

2 Томский политехнический университет, Томск, Россия 

ПРИМЕНЕНИЕ МЕТОДА АНАЛИЗА ИЗОБРАЖЕНИЙ  

В ИССЛЕДОВАНИИ И СТАТИСТИЧЕСКОЙ ОЦЕНКЕ 

ПАРАМЕТРОВ ЧАСТИЦ ТВЕРДОЙ СОСТАВЛЯЮЩЕЙ 

СВАРОЧНЫХ АЭРОЗОЛЕЙ СИЛИКАТНОГО  

И ОКСИДНОГО СОСТАВА 

Параметры частиц твердой составляющей сварочных аэрозолей представляют интерес с 
точки зрения оценки их токсичности и характера влияния на организм человека. Методом стати-
стической обработки сведений о размерах мелкодисперсных частиц, как правило, оценивается 
только фракционный состав, без учета морфологии, состава и оценки внутренней конфигурации. 
Тогда как именно эти параметры и позволяют максимально точно оценить влияние частиц на ор-
ганизм человека. Исходя из этого именно эти параметры следует учитывать в моделировании 
характеристик образования сварочных аэрозолей при проектировании средств индивидуальной 
защиты от их влияния и мероприятий по снижению их негативного воздействия на организм че-
ловека. Актуальной является статистическая оценка параметров фракционного состава частиц 
сварочного аэрозоля с учетом морфологии, химического состава и их внутренней конфигурации, 
поскольку данные параметры во многом определяют взаимодействие частиц с живыми тканями. 
При анализе изображений частиц сварочных аэрозолей (РЭМ) получены сведения о дисперсном 
составе в диапазоне от 100 нм до 150 мкм с учетом морфологии (сферические и несферические 
частицы). Выявлено, что в независимости от вида покрытия электрода преобладают сфериче-
ские частицы, причем преимущество сферических частиц наиболее ярко выражено в диапазоне 
от 100 до 300 нм. Методом трехмерной реконструкции поверхности частиц могут быть получены 
сведения о высоте элементов микрорельефа частиц, величине их активной площади и других 
параметров, характеризующих взаимодействие частиц с биологическими тканями. Продемонст-
рировано, что метод сегментации изображения в совокупности с результатами рентгеноспек-
трального анализа позволяет установить фазовый состав отдельных частиц.  

Ключевые слова: аэрозоль, сварка, обработка изображений, профессиональные риски, 
покрытие электродов, ручная дуговая сварка, фракционный состав, дисперсность, трехмерная 
реконструкция, сферические частицы, несферические частицы. 
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APPLICATION OF DIGITAL IMAGE ANALYSIS  

IN THE RESEARCH AND EVALUATION OF STATISTICAL 

PARAMETERS OF SOLID PARTICLES WELDING FUMES  

The parameters of the particles of solid component of welding fumes are of interest in terms of 
assessing their toxicity and the nature of the influence on the human body. Statistical treatment of data 
on the size of fine particles is usually evaluated only fractional composition, without taking into account 
the morphology, composition and evaluation of the internal configuration. Whereas, these parameters 
and allow you to accurately assess their impact on the human body and that these parameters should 
be considered in the modeling parameters of the welding aerosol formation in the design of personal 
protective equipment on their impact and measures to reduce their negative impact on the human body. 
Relevant source of statistical evaluation of parameters of fractional composition of the particles of the 
welding aerosol based on morphology, chemical composition and their internal configuration, since 
these parameters are largely determined by the interaction of particles with living tissues. In the analysis 
of aerosol particles of welding images (SEM), information obtained particulate composition in the range 
from 100 nm to 150 microns based on morphology (spherical and non-spherical particles). It revealed 
that regardless of the type of electrode coating prevail spherical particles, spherical particles and the 
advantage is most pronounced in the range of 100 to 300 nm. The method of three-dimensional recon-
struction of the surface of the particles can be obtained information about the height of the elements of 
the microrelief of the particles, the size of their active area and other parameters characterizing the  
interaction of particles with biological tissues. Demonstrated that image segmentation method in con-
junction with the results of X-ray analysis allows to establish the phase composition of the individual  
particles. 

Keywords: aerosole, welding, image processing, professional risks, covering the electrodes, 
manual arc welding, fractional composition, dispersion, three-dimensional reconstruction, spherical  
particles, non-spherical particles. 

Введение 

Параметры частиц твердой составляющей сварочных аэрозолей 
(ТССА) представляют интерес с точки зрения оценки их токсичности и 
характера влияния на организм человека [1–7]. За полувековой период 
их изучения были разработаны индивидуальные средства защиты, 
снижающие вероятность попадания частиц ТССА через дыхательные 
пути, а также были усовершенствованы методы оценки вредных усло-
вий труда при сварочном производстве. Последние исследования в об-
ласти токсикологии показывают, что нейтрализация ультрадисперсных 
частиц ТССА силикатного и оксидного типа по-прежнему актуальна, 
поскольку значительная часть этих частиц не разлагаются в организме 
и могут проникать в организм человека, минуя общераспространенные 
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средства защиты, внедряться в структуру живых тканей и вызывать в 
них патологические процессы [8–11]. 

Актуальность  

Несмотря на накопленный опыт в изучении состава, свойств  
и морфологии твердых частиц сварочного аэрозоля, сведения об их 
морфологии остаются неупорядоченными и носят описательный ха-
рактер. Методом статистической обработки, как правило, оценивается 
только фракционный состав аэрозолей, без учета морфологии, состава 
и оценки внутренней конфигурации, но именно эти параметры и по-
зволяют максимально точно оценить их влияние на организм человека 
и именно их следует учитывать в моделировании параметров образо-
вания сварочного аэрозоля при проектировании средств индивидуаль-
ной защиты от их влияния и мероприятий по снижению их негативного 
воздействия на организм человека. Актуальной является статистиче-
ская оценка параметров фракционного состава частиц ТССА с учетом 
морфологи, химического состава и внутренней конфигурации, по-
скольку данные параметры во многом определяют взаимодействие 
частиц с живыми тканями. 

Существующие методы оценки дисперсности и гранулометриче-
ского состава ТССА обладают рядом недостатков. Лазерные, диффу-
зионные анализаторы не дают представления о морфологии частиц и, 
как правило, ориентированы на изучение частиц в определенном раз-
мерном диапазоне, при этом представить гранулометрический состав 
ТССА в широком диапазоне представляется возможным только с ис-
пользованием нескольких методов сразу. Известно, что частицы ТССА 
образуют кластеры и агломераты [12], параметры ТССА, входящих в 
их состав, практически не исследовались в отдельности и не сравнива-
лись с параметрами одиночных частиц. Методы, предполагающие аэ-
родинамическую сепарацию, не отражают реального количества агло-
мератов, так как они разрушаются в процессе проведения анализа. 
Единственным способом, который позволяет оценить размер, морфо-
логию, состав и в отдельных случаях внутреннюю конфигурацию час-
тиц ТССА с минимальным воздействием на них, является метод рас-
тровой электронной микроскопии с применением рентгеноспектраль-
ного микрозондового анализа. Однако электронной микроскопией 
достаточно сложно оценить гранулометрический состав, морфологию, 
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состав или иные характеристики частиц ТССА статистически, поэтому 
исследователи, как правило, используют в качестве средства изучения 
индивидуальных частиц РЭМ. С помощью РЭМ достигнуты успехи  
в классификации частиц ТССА как с точки зрения морфологии и внут-
реннего строения, так и с точки зрения состава. Однако практики ко-
личественной и статистической оценки распространенности тех или 
иных типов частиц на данный момент не существует. Извлечь макси-
мальную информацию о параметрах ТССА из результатов РЭМ, на 
наш взгляд, возможно с привлечением дополнительных средств иссле-
дования – таких, например, как анализ изображений с помощью спе-
циализированного программного обеспечения. 

Цель и задачи исследования 

Целью настоящей работы является оценка возможности исполь-
зования метода анализа изображений в исследовании и статистической 
оценке параметров твердых частиц ТССА. Сведения о морфологии 
частиц ТССА представляют большой интерес с точки зрения оценки 
механизма их воздействия на здоровье человека, поскольку результаты 
исследований, представленные в последних работах [13], указывают на 
то, что морфология частиц, конфигурация их поверхности и внутрен-
нее строение являются важнейшими факторами, обусловливающими 
уровень интенсивности и характер взаимодействия частиц ТССА с жи-
выми тканями, микроорганизмами и клеточными структурами в орга-
низме человека. Для достижения обозначенной цели в настоящей рабо-
те выделены две основные задачи, которые предполагается решить ме-
тодом анализа изображений, полученных РЭМ:  

1) оценка гранулометрического состава частиц ТССА с учетом 
морфологии (сферические и несферические частицы); 

2) оценка морфологии и внутреннего строения частиц ТССА. 

Материалы, оборудование и средства анализа 

Для образования сварочного аэрозоля проводилась ручная элек-
тродуговая наплавка металла покрытым электродом, поскольку при 
данном виде сварочных работ контакт человека со сварочным аэрозо-
лем максимальный. В качестве материала для проведения наплавки 
использовали прокатные листы толщиной 10 мм из стали Ст3. Для на-
плавки применяли электроды d = 3 мм: основное (Kobe Steel LB 52U), 
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рутиловое (ESAB ОК 53.70, ОК 46.00), целлюлозное (Kjellberg-
Finsterwalde Prima Blue) и кислое (ильменитовое) покрытия, соответст-
вующие составу МР-3М (ТУ 1272-303-00187211–2002). В качестве ис-
точника питания использовался сварочный выпрямитель ВД-306, 
предназначенный, в том числе, для питания электрической сварочной 
дуги постоянным током при ручной дуговой сварке, в закрытых поме-
щениях, с естественной вентиляцией. 

Осаждение частиц ТССА осуществлялось на поверхность угле-
родного скотча в форме диска d = 4 мм, предназначенного для прове-
дения исследований методом РЭМ. 

Процесс наплавки проводили в условиях сварочной лаборатории 
с применением местной принудительной вентиляции. Наплавка прово-
дилась на сварочном токе 90 А. Оседание сварочных аэрозолей осуще-
ствлялось на поверхность углеродного скотча, находящегося на рас-
стоянии 300 мм от сварочной дуги. Местная принудительная вентиля-
ция служила для образования направленного потока сварочного 
аэрозоля и достижения равномерного оседания его частиц на поверх-
ность углеродного скотча. 

Образцы частиц ТССА, осажденные на углеродный скотч, иссле-
довали на сканирующем электронном микроскопе высокого разре-
шения с рентгенофлуоресцентной приставкой S3400N HITACHI  
(Япония). 

Изображения анализировались с помощью универсального про-
граммного обеспечения ImageJ FiJi. 

Результаты исследований  

Наиболее доступный для оценки параметр – это гранулометриче-
ский состав частиц ТССА. Для этого может использоваться неограни-
ченное число цифровых изображений, полученных на различных уве-
личениях (рис. 1). Рассмотрим принцип оценки гранулометрического 
состава частиц ТССА с привлечением анализа изображений.  

В целом процесс делится на несколько этапов: настройка мас-
штаба изображения, настройка контраста, корректировка изображения, 
сегментирование, подсчет и анализ параметров частиц. 

Для настройки масштаба изображения используется функция 
Analyze → Set Scale, она позволяет задать корректное соотношение ре-
ального  геометрического  размера  и размера пикселя на         изображении.  
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Рис. 1. Пример изображений частиц ТССА, использованных для оценки  
гранулометрического состава методом анализа изображений [14] 
 

Для настройки контраста используется функция «уровни» – Image → 
Adjust → Threshold, которая позволяет удалить с изображения ненуж-
ную информацию, например цветовое искажения фона, общее загряз-
нение поверхности скотча, его неровности и т.д., путем перевода изо-
бражения в бинарный вид (рис. 2, а). Затем производится корректиров-
ка изображения с последовательным использованием инструментов 
Process → Binary → Fill Holes; Process → FFT → Bondpass Filter; 
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Image → Adjust → Threshold, которые, при совместном использовании, 
позволяют избавиться от световых искажений, возникших при съемке 
(рис. 2, б). Затем применяется инструмент Process → Binary → 
Watershed, который позволяет достигнуть отделения частиц, располо-
женных близко друг к другу, в автоматическом режиме (рис. 2, в) для 
того, чтобы при анализе количества частиц они не были определены  
в качестве одной цельной частицы. Анализ изображений позволяет 
произвести оценку гранулометрического состава как отдельных час-
тиц, так и частиц, входящих в агломераты и осаждающихся на поверх-
ности отдельных крупных частиц (рис. 2, г). 

В последующем при помощи инструмента Analyze → Analyze 
Particles производится анализ параметров и подсчет частиц. Результат 
в виде табличных данных, отражающих площадь частиц и степень их 
сферичности (от 1 до 0, где 1 – идеальная сфера), обрабатывается  
в MS Excel с помощью спецпакета анализа данных. В качестве сфери-
ческих частиц в данном анализе принимаются частицы с параметром 
сферичности от 0,8 до 1 [15]. Результаты оценки гранулометрического 
состава частиц ТССА с учетом морфологии, характерной для разных 
типов электродного покрытия, представлены на рис. 3. 

Оценка морфологии и внутреннего строения частиц производи-
лась с помощью функции Analyze → 3D Surface Plot. Эта функция по-
зволяет создать трехмерное изображение поверхности частицы, оцени-
вая высоту как математическую производную от показателя яркости 
отдельных участков изображения (рис. 4).  

Для применения данного инструмента обработки изображения  
к сферическим и околосферическим частицам аэрозолей требуются 
корректировки. Это прежде всего связано с неравномерным распреде-
лением контраста по поверхности частицы в процессе фиксирования 
изображения при микроскопии. Корректировка подразумевает на-
стройку освещения в любом известном графическом редакторе. При-
мер настройки изображения представлен на рис. 5, данная настройка 
призвана свести к минимуму искажения света. 

Исследования [16] по оценке влияния параметров микрорельефа 
поверхности имплантов [17] на их приживаемость доказывают, что на 
взаимодействие с живыми тканями неразлагаемых в организме частиц 
влияет не только их состав и размер, но и параметры поверхности.  
Однако  оценить  поверхность частиц                 ТССА  количественно с помощью  
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Рис. 3. Дисперсный состав частиц ТССА различной формы, образованных 
электродами разных типов:           а – основного; б – рутилового;          в – целлюлозного;  

г – кислого 
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Рис. 4. Трехмерная реконструкция частиц ТССА с разными типами покрытий 
электродов: а – основное; б – рутиловое; в – целлюлозное; г – кислое 
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                                  а                                                     б 
 

 
                                  в                                                        г 

 
Рис. 5. Обработка изображения сферической частицы ТССА, образованной 
рутиловым покрытием: а – исходное изображение; б – после обработки;  

в и г – трехмерная реконструкция 
 
прямых измерений практически невозможно. Моделирование трехмер-
ной поверхности частицы позволяет наглядно представить данные о 
высоте элементов ее микрорельефа и толщине стенки, если речь идет  
о пустотелых и сложно организованных частицах, подобный метод по-
зволяет получить информацию о поверхности сколов частиц и визуа-
лизировать строение отдельных агломератов. 

Некоторые частицы ТССА имеют развитую структуру поверхно-
сти, параметры которой могут быть также оценены с использованием 
принципов сегментации изображения посредством отдельного прило-
жения (Plugins) к программе под названием MorphoLibJ. Благодаря та-
кой функции на поверхности частицы можно произвести подсчет ко-
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личества отдельных фаз, совмещая полученные сведения с элементным 
составом каждой из них (таблица), можно определить фазовый состав 
частицы ТССА (рис. 6).  

 

Элементный состав отдельных фаз частицы ТССА 

Содержание, % Компонент 
Фаза 1 Фаза 2 Фаза 3 

O 60,0 17,4 65 
Al 0,2 1,2 0,3 
Si 4,2 2,3 3,5 
Ti 0,4 0,5 0,3 
Mn 3,0 4,1 2,6 
Fe 32,2 74,5 28,3 

 

 
                                    а                                                  б 

 
в 

 
 
 
 
 

Рис. 6. Результат фазового анализа частицы ТССА, образованной при наплавке 
электродом с рутиловым покрытием, методом сегментации: а – исходное  
фото; б – изображение, обработанное методом сегментации; в – фазовый состав 

частицы 

Фаза 1 

Фаза 2 

Фаза 3 
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Кроме того, данные, полученные при таких измерениях, позво-
ляют оценить площадь активной поверхности частицы и ее емкость,  
что является немаловажным аспектом при оценке взаимодействия час-
тиц с биологическими тканями. 

Заключение 

Таким образом, при анализе изображений частиц ТССА по дан-
ным РЭМ получены сведения о дисперсном составе частиц ТССА  
в диапазоне от 100 нм до 150 мкм с учетом морфологии (сферические  
и несферические частицы). Выявлено, что вне зависимости от вида по-
крытия электрода преобладают сферические частицы, причем пре-
имущество сферических частиц наиболее ярко выражено в диапазоне 
от 100 до 300 нм.  

Выявлено, что методом трехмерной реконструкции поверхности 
частиц ТССА по алгоритму обработки затемненных и светлых участ-
ков изображения могут быть получены сведения о высоте элементов 
микрорельефа частиц, величине их активной площади и других пара-
метрах, характеризующих взаимодействие частиц с биологическими 
тканями. Продемонстрировано, что метод сегментации изображения  
в совокупности с результатами рентгеноспектрального анализа позво-
ляет установить фазовый состав отдельных частиц ТССА.  
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